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A letter direct from the editor desk highlighting on June edition 
We are going to publish another fabulous issue of Sketchup Ur Space. In this issue we are mainly focusing on Sketchup 
Extension Warehouse. EW is a great source for different kinds of sketchup plugins and add-ons. The sketchup users can 
search and set up add-ons for sketchup through EW. 

The sketchup extension warehouse contains various categories which range from rendering, reporting, drawing, 
text/labeling, 3d printing, scheduling, drawing, text/labeling, 3d printing, scheduling, import/export, developer tools, 
productivity, animation, energy analysis etc. These extensions are useful for various industries like Architecture, 
Engineering, Gaming, Kitchen & Bath, Woodworking, Heavy Civil, Interior Design, Landscape Architecture, Urban Planning, 
Construction, Film & Stage, Education and other. 

In our main cover story there will be a nice and brief presentation on various aspects of Sketchup Extension Warehouse. 

We always strive to make our magazine a learning platform for newbie sketchup users. For this purpose, we include lots 
of tutorials in the tips & tricks section of the magazine. In the current issue there will 5 (five) tutorials on sketchup. Out of 
five sketchup tutorials, three tutorials are presented by Simone Piccioni, a renowned renderer who studied at Faculty of 
Architecture (UNAM). All the tutorials from Simone focus on how to model Buzz Ligthyear with Sketchup, how to create 
the thread of a screw with SketchUp and how to shape a shelby through sketchup. 

There are other tutorials presented by Glare Technologies, the parent company of Indigo Renderer and Justin Geis, the 
most promising sketchup modeler. Glare Technologies provides an useful tutorial that focuses on how to model a simple 
swimming pool in SketchUp and Indigo. In his tutorial, Justin shows how to produce Curved Extruded Letters on a Curved 
Sign in SketchUp without Plugins. 

In article section, Mohab M Refaat, who studied at faculty of urban and regional planning, has presented an exclusive article 
that highlights how to import any design from CAD to Sketchup. There will be 3 (three) more articles provided by the team of 
sketchup ur space which range from how to improve your sketchup skills through various tips on sketchup tools & various 
intermediate and advance modeling practices, how to make your design appealing by inserting 3d text to any sketchup 
model and how to produce scenes/animations through sketchup. 

In Interview section, there will be exclusive interview with Nomer Adona, the well know designer, architect and teacher. 

In the news and blog section of the magazine, the readers will get up-to-date information about sketchup. 

Hope that you will like this publication of Sketchup ur Space. We will love to hear feedback from you. 

Hope our readers will enjoy this issue to a great extent. 

If you have any queries concerning publication, subscription, troubles navigating the site, please mail us 
atrajib@sketchup-ur-space.com 

 

Best wishes  
Rajib Dey 

Editor 

  

mailto:rajib@sketchup-ur-space.com�
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Q&A with V-Ray for SketchUp artist and blogger Nomer Adona 

Since the release of SketchUp 4, 3D visualization with SketchUp has been a hobby for Nomer Adona. He once worked in 
the visualization industry – only using free-hand drawings to visualize his concepts – and now teaches art and design at 
Saigon South International School (SSIS) in Vietnam. 

Nomer began integrating V-Ray for SketchUp into his visualization process with the plug-in’s first beta release, and 
continues to use it on a regular basis. “V-Ray is considerably fast in comparison to other rendering engines. I have no doubt 
that the combination of quality and speed is the main reason why visualizers like me love V-Ray for SketchUp,” Nomer said. 

 

In addition to teaching art and design to his students at SSIS, he’s become a well respected teacher within the SketchUp 
and V-Ray communities by publishing online tutorials on his personal blog, nomeradona.blogspot.com. Since 2009, he’s 
also been a contributing writer for SketchUpArtists.org, where he shares his SketchUp and V-Ray for SketchUp 
experiences. According to Online Editor and Co-Founder of SketchUpArtists, “Nomer is a master of 3D digital still life and 
interiors. He has a passion for bringing 3D and art together and his expertise has always inspired and amazed. His work 
always reveals his skills in composition and the knowledge of how colors work, whether it’s hand drawn illustration, 
photography or 3D rendering … he is a true SketchUp artist and render master.” 
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We asked Nomer a few questions about his experiences as a teacher of art, design, SketchUp, and V-Ray for SketchUp. 
Here is what he had to say. 

 

Saigon South International School (SSIS) is a very prestigious school in Asia with a strong academic and a balanced 
program. It has a beautiful suburban campus overlooking a river and the facilities are first-rate. Most of all, its greatest 
assets are the students and the teaching faculty, the reason I opted to stay and would want to continue teaching in this 
school. 

What made you want to teach art and design at Saigon South International School? 

First of all I love teaching: I love inspiring, motivating, engaging people particularly in art and design. I also love sharing my 
knowledge and learning from other people. I found teachers in international schools to be open minded, knowledgeable and 
most of all full of life experiences in a multi-cultural world. I found that most students in international schools are risk takers, 
inquirers, opinionated and reflective. The environment of teaching in an open arena is much more appealing than working in 
a four-walled architectural office. 

Do you teach your students how to use V-Ray and/or SketchUp? 

SketchUp was introduced in our school. We tried to implement using this software from middle school to high school. Last 
year our middle school started introducing in connection with the math curriculum. I am also regularly teaching my 
Integrated and IB art students to use SketchUp. This year we are piloting the introduction of the V-Ray for SketchUp engine. 



 

5 | P a g e  
 

 

 

Have you worked any jobs in 3D visualization, or has it been only a hobby for you? 

Since 1990 my work was mainly conceptualization, and you have to be a visualizer in order to express your concepts. Back 
then I only used free-hand drawing. Everything changed when I bought my first computer 1997 and I began studying 
visualization using 3ds Max. Such study was on and off since most of my work was conceptualization, and I found that hand 
sketching was faster than modeling digitally. 

My interest with 3D digital visualization was revived when I was introduced by a colleague to SketchUp 4, which was very 
quick way of doing conceptual work. Because I was teaching already then, visualization became a hobby, a way of releasing 
my creative expression. From time to time, I’d accept rendering services, but it was not really my main job. 

When you grow with 3D visualization, you start looking for different possibilities. Through the Sketchucation.com forum, I 
learned that the development of V-Ray for SketchUp was ongoing. When the first beta version of V-Ray for SketchUp was 
released (the one with ASGvis watermarked), I tried and started using it. Since then, I started using it regularly. Much of my 
learning was through trial and error, since there were very few online learning resources at that time (the manual was not 

When did you begin using V-Ray for SketchUp, and how did you learn how to use the plug-in? 
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even there). The ASGvis forum was always a very good place where I could post questions and read other user's 
discoveries. 

 

What do you like about V-Ray and SketchUp? 

The quality it produces. It is considerably fast too against other rendering engines. I don't have any doubt that the 
combination of quality and speed was the main reason why visualizers like me love V-Ray for SketchUp. 

 

 

What is your favorite project you’ve designed with V-Ray and SketchUp so far, and why is it your favorite? 

My favorite was when I used it for my worship series painting. I used the software basically to study lighting before painting. 
It was an unorthodox approach on how 3D digital media visualization could be used with traditional painting media. I think 
this is the way I want to pursue my art. 
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View Nomer Adona’s blog at

What or who inspires you? 

I love media exploration. Discovering new things and then sharing what I have discovered with others is what inspires me 
most. When it comes to people, the guys who inspire me are "Biebel" and some Filipino visualizers like "architekthura" and 
"celes." 

 nomeradona.blogspot.com, and read his posts onSketchUpArtists.org. 

 

  

http://nomeradona.blogspot.com/�
http://www.sketchupartists.org/�
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Transform your sketchup skills to the next level with sketchup extension 
warehouse 

Extension Warehouse of SketchUp is a great source for all 3D Modeling Professionals as they can enhance their 3d 
modeling skills by looking for proper plugins to fulfill their requirements. 

Extensions refer to an additional features and functionality that can be easily included with a sketchup program. The 
extensions perform like a third-party scripts to provide definite functions automatically. If any plugin is helpful and trendy, the 
owners of a program prefer to purchase the extension and integrate it into upcoming releases of the program. 

SketchUp’s Extension Warehouse is launched in 2013. It is an online repository of extensions and plugins. To use the 
Extension Warehouse, open SketchUp and select Window > Extension Warehouse and explore through Extension 
Warehouse within SketchUp. Just sign into your Google account and start looking for a particular extension as well as 
different categories. After that select install and pursue the instructions. 

The extension warehouse facilitates the users to search for a productivity boosting function or an advanced rendering 
application. Besides, the extension warehouse is a great source for handling an extension library. If any user wants to 
instantly update, transfer, or re-install all their extensions, just log-in to Extension Warehouse within SketchUp and avail 
some exclusive features through “My Extensions” page. 

All the extensions belong to different types of sectors that range from architecture, engineering, gaming, kitchen & bathroom 
installations, woodworking, heavy civil, interior design, landscaping, urban planning, construction industries, film & stage and 
education. 

There are wide array of categories like rendering, reporting, drawing, text and labeling, 3d printing, scheduling, import & 
export, developer tools, productivity, animation and energy analysis. 

It is expected that till date, more than 1 million extensions are downloaded from Extension Warehouse as well as more than 
50 developers have contributed near about 245 extensions. 

Each and every day, several developers present new extensions and upgrades. These extensions transform Sketchup as 
an inevitable tool for 3D modelers and designers and add diversified features to Sketchup. 

Extension Warehouse is also considered as the useful place for creating and allocating various open source projects that 
range from SketchUp STL extension, Shapes,WikiHouse and Developer Tools. 

With the arrival of sketchup 2014 (it includes a new extension warehouse), it becomes easier to pursue and set up these 
extensions while applying either SketchUp Pro or SketchUp Make. 

While setting up extensions from Extension Warehouse, the users can log-in to the extension warehous from SketchUp 
2014 and "Install All" under "My Extensions." It will put in all the available extensions which are well-matched with SketchUp 
2014. 

As the Ruby environment is upgraded to version 2.0 in sketchup 2014, the users have to follow a new way for dealing with 
the extensions. Besides, the users will not be able to access all the possible plugins in the extension warehouse as well as 
paid plugins. 

Some users have to get through their old plugin list individually, look for that plugin in the Extension Warehouse, set up the 
plugin, and move ahead next. As soon as the plugins are managed through the Extension Warehouse, it becomes 
considerably easier to re-install these extensions once the new versions of SketchUp will be available in the future, or if you 
have a new computer and installation of a fresh copy of SketchUp 2014 is necessary. If the user set up plugins from the 
Extension Warehouse in SketchUp 2013 and now it is necessary to set up the same plugin in SketchUp 2014, there exists 
an Install All button in the Extension Warehouse to set up any SketchUp 2013 plugins into SketchUp 2014 instanly. It is 
applicable, if those plugins are updated to support 2014. 

How to set up extensions 

Automatic process 

If you possess Sketchup 2013 or latest version, you can access to the extension warehouse by going Window > Extension 
Warehouse. Once you click it, the following window will be visible. 

https://extensions.sketchup.com/en/content/sketchup-stl�
https://extensions.sketchup.com/en/content/shapes�
https://extensions.sketchup.com/en/content/wikihouse�
https://extensions.sketchup.com/en/content/sketchup-developer-tools�
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After getting the Extension Warehouse window open, you have to sign in to your account. The ‘Sign in’ button is available in 
top right. Without sign in, you can’t download or set up the extensions this way. 

Search through your favorite sketchup extension and after getting one, hit the download button with red color available in 
the upper right corner. 

 

You have to pass by some pop-up menus. Just pursue them to set up your extension. 

• Visit Window>Preferences 

Manual Process 

Find an extension on the web. Ensure that your .rbz file is saved in a suitable and proper location to get if effortlessly. It is 
recommended to place it in a Sketchup/Tools folder. In older versions, it may be in the Sketchup/Plugin folder. 

• Ensure that Extensions are selected on the left side 
• Press Install Extension at the bottom left 
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Import your design from CAD to Sketchup 
1

 

. import your design from cad to sketchup. 

2

 

. draw circle diameter equal to diameter fountain then delete half of fountain & use make face plugin. 

3. after using make face plugin , rotate the shape to angel = 90. 
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3

 

. using follow me tool. 

3. using follow me tool. 
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4

 

. using materials. 

5. follow the same steps with water shape. 
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6

 

. make the fountain & water shape group. 

7. merge the fountain & water shape together. 



 

14 | P a g e  
 

 

8

 

. make the fountain base and put your materials. 

9

 

. merge the base & the fountain. 
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Final 
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Improve your sketchup skills through some online sketchup trainings 
2014 

Enhance your sketchup skills by learning sketchup through a collection of easy-to-follow online video tutorials which focus 
on various tips on sketchup tools, various intermediate and advance modeling practices. By undergoing these tutorials the 
sketchup users will be able to draw and communicate in 3D efficiently as well as make stunning achitectural, civil, 
mechanical, and video game design. 

Free online sketchup tutorials for beginners 

Get trained with sketchup through some free online tutorial series. These tutorials are useful for beginners as well as 
advanced users. Learn everything about sketchup. The tutorials will focus on the 3D modeling and design industry. One can 
also get support for acquiring any jobs and clients with his sketchup skills. 

The tutorial will be based on various projects. One can get familiar with all the tools and features by making a shed. 

https://www.youtube.com/watch?v=YGdLwE4Ue-c 

How to apply offset tool in sketchup 

TeachMeToday presents an instructional tutorial on sketchup. By viewing this tutorial, one can learn the various applications 
of offset tool in sketchup. 

https://www.youtube.com/watch?v=9GnWVPFHWyM 

Apply sketchup to make realistic bowl/utensils 

Learn how to apply sketchup for producing realistic type of bowl. The kerkythea rendering plugin is used to give a realistic 
look to the bowl. Other tools like subdivide and smooth plugin are used to create the model of the bowl. 

https://www.youtube.com/watch?v=oy0MmiQHv1g 

 

  

https://www.youtube.com/watch?v=YGdLwE4Ue-c�
https://www.youtube.com/watch?v=9GnWVPFHWyM�
https://www.youtube.com/watch?v=oy0MmiQHv1g�
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How to generate 3d text in sketchup and place, scale & manoeuvre it 
The sketchup users can insert 3d text to their models to get a level of detail which can make their design outstanding. Go 
through the following processes to learn how to produce a 3d text in sketchup. 

Learn to make 3d text in sketchup: 

• Visit Tools > 3D Text 
• Provide your settings, font, and put in desired text in the field 
• Press Enter 
• Opt for the face or plane where you prefer to set your text 

In order to move or locate a 3d text, pursue the following steps:- 

• Select your preferred text to move, apply the shortcut button ‘M’ to quickly move it. 
• In order to align text on center position of something , go into the group and sketch a rectangle around the areas of 

your text. Snap the central point of your rectangle to the middle of the edge to be center on. Click right with your 
mouse button on the rectangle and select Hide to hide it from view. 

• In order to rotate to a specific face or axis, select the rotate tool on the right access on any face and press shift to 
lock to that axis. 

• For moving towards a specific axis or edge, pick it, and hold shift. 

In order to obtain a particular Size of 3D Text: 

• There exists an option with the 3d text to obtain the height of your text. For getting a particular height, just remake 
your 3D Text with instructions given above under the head ‘Learn to make 3d text in sketchup’. 

• In order to get a particular width of the text, determine the existing length of your text. Change your existing length 
to a single unit. After that, divide your preferred width with your actual width. You’ll receive a decimal number which 
should be provided once you choose to scale your text. 

• For getting a particular height and width, opt for the Height method and manually position your text nearer in or... 
• Distort your text to the preferred size. 

Go through the following exclusive video to get live demo: 

https://www.youtube.com/watch?v=jTZmwMwAKO4 

 

https://www.youtube.com/watch?v=jTZmwMwAKO4�
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How to make scenes and animations easily through Sketchup 
Trimble Sketchup previously Google sketchup is a free 3d modeling application that can be utilized to produce complicated 
& realistic 3d models quickly. 

With its powerful technology, sketchup along with various plugins can render any model for making pragmatic images. 
Sketchup contains various toolset useful for generating a set of scenes which are views of the model. Every scene comes 
with a diversified view that is tied with each other to make an animated walkthrough of the design. 

Google SketchUp is a 3D modelling program that allows the user to create complex models easily. SketchUp allows you to 
render your model so that realistic images are created. Part of SketchUp’s toolset is the ability to create a set of scenes 
which are views of your model. Each scene can show a different view that can be linked together to form an animated walk 
through of your design. 

Follow the instruction given below to make scenes and animation with sketchup:- 

• Open SketchUp and submit the drawing according to your choice. Use orbit, pan and zoom tools to form the initial 
view. Thus your first scene will be created. 

• Select the menu bar, opt for WindowScenes to open the Scenes dialog box. Select the plus sign and the first view 
is made as Scene 1. A tab alias Scene 1 will be visible over the drawing window. 

• Form your second view and after make it perfect select the plus sign in the Scenes dialog box. Repeat the process 
for as many scenes as required. Apply the check box options within the dialog box and modify the model to adjust 
the scenes appearance and its viewpoint. 

• Select ViewAnimationPlay to view your scenes connected together to create a walk through. One will be able to 
edit several options as well as how long the animation lapses at each view by selecting ViewAnimationSettings. 

• Select FileExportAnimation and choose the location to save the file in the dialog box as an AVI file. One can set the 
screen size of any AVI file through the Options button in the dialog box. 

• One is able to alter the order of the scenes in the animation within the Scenes dialog box. Focus on the scene one 
prefers to move and transfer it in it’s new position through the up and down arrows. One can make changes among 
scenes with the tabs formed over the drawing screen. 

• At the time of making an AVI file, if the screen size becomes too large then it might make your computer slow at 
the same time as the video is formed. Test how your animation will appear in a small version prior to make the final 
version. 
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How to download and set up Sketchup 
Learn the process to download and set up sketchup in your computer system. 

The process is totally free and the users will be able to download the functional version of sketchup. There will be option to 
buy SketchUp Pro containing additional software and tools. 

In order to download and set up sketchup, the following steps should be undertaken. 

1

 

. Visit www.sketchup.com. The following page will be visible. 

2. Select the button marked with red color that shows “Download SketchUp.” 

3

 

. It will transform the page to a new one enquiring why you’re downloading SketchUp. If you do not prefer to apply 
sketchup for a professional or commercial application, just opt for the “Personal Projects” option. For each option 
(professional, professional and commercial), you will be provided with an eight hour trial of SketchUp Pro’s features and a 
permanent copy of the free version of SketchUp. 
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4. Choose your operating system – Windows for a PC and Mac for a Mac. 

5. Now review the license agreement thoroughly, then turn on the box ensuring that you consent to the license agreement. 
After performing this, the button showing “Download SketchUp Make” will be change to red color like the following. 

Download Sketchup Make 

6. (Optional) – There will other box marked as “Send me SketchUp news and tips.” You can check or un-check it. If you 
check it, you will get the SketchUp newsletter as it is available. The newsletter infrequently goes out with SketchUp news 
and other materials. 

7. Select the “Download SketchUp Make” button to download the setting up program to your computer. 

8

 

  

. Open the downloaded files. Abide the instructions to set up SketchUp on your computer. Press finish to go out from the 
set-up process. 

Thus sketchup will be installed on your computer. 

http://www.sketchup.com/products/sketchup-make�
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Trimble launched two New Concept Applications alias Sketchup Scan and 
Trimble Through The Wall for Google's Project Tango Program 

Trimble just introduced two concept applications well matched with the most updated tablet platform of Google's Project 
Tango program. 

The motto of Trimble is to provide mobile appliances a human-scale perceptive of space and motion. The Trimble concept 
applications consist of SketchUp Scan and Trimble Through The Wall and these focus on prospective new techniques for 
construction professionals to apply their Google tablets for getting more perfection and insight to their work in the future. 

By applying depth sensors on the Tango device, SketchUp Scan can be utilized to instantly take the view of a room, 
apartment or complete floor in 3D and automate the process for generating editable 3D Sketchup model. 

This model can be distributed through leading social media platforms like Google+, Facebook and Twitter as well as through 
email. One can also upload the model from the Tango device to the 3D Warehouse, an exclusive platform for placing and 
distributing 3D models. 

Being capable of editing the 3D model of the space correctly once the image is taken, facilitates the users to insert various 
features which range from windows and doors, to furniture, office equipment or nearly anything else through unlimited 3D 
models accessible in the 3D Warehouse. 

Trimble Through The Wall make the tracking abilities of Tango appliances more efficient to find out what is placed inside 
walls and other structures. By acquiring the data from Computer-Aided Design (CAD) or 3D Building Information Modeling 
(BIM) software like Tekla Structures, Trimble Through The Wall can demonstrate and superimpose pipes, electrical wires 
and heating, ventilation and air conditioning (HVAC) infrastructure on top of walls, at their exact location. 

SketchUp Scan and Trimble Through The Wall are concept applications operating on the Project Tango Tablet development 
kits. Google present these development kits only to professional developers, providing a "sandbox" inside which developers 
will be able to try out with several concept applications. The final functionality of Trimble's concept applications are still 
under beta testing stage. For getting further updates, visit www.trimble.com/ProjectTango. 

 



 

22 | P a g e  
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Sketchup mobile viewer 
Sketchup mobile viewer is the most updated onsite presentation tool for sketchup users. It is compatible with the iOS and 
Android tablets. 

SketchUp Mobile Viewer tablet app can empower the users to orbit, walk around, and present their 3D models as well as 
search through the complete 3D Warehouse. 

With multi-touch and pinch-zoom features, the sketchup users can deal with SketchUp models wherever they appear. Apply 
predetermined cameras to hop over the projects instantly. 

The sketchup users can bring their 3D Warehouse collections and models everywhere they like. If the users are busy with 
an significant meeting or project review, they can store their models for offline orbiting through SketchUp Mobile Viewer. 

 

The sketchup users will be able to model anything from very beginning. Look into SketchUp’s 3D Warehouse to find if it 
exists already there. Explore through your requirements and then interact with 3D models in SketchUp Mobile Viewer. 

Downloadable link 

http://www.sketchup.com/products/sketchup-mobile-viewer�
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How to Create Curved Extruded Letters on a Curved Sign in SketchUp 
without Plugins 

A fairly simple way to get SketchUp to create curved lettering without having to learn how to use any of them. 

Let’s say you had a curved sign like this – 

 

When you create text with the 3d Text Tool, it comes in on a flat plane, so it looks like this. 

 

Not exactly what we’re looking for, right? The text doesn’t follow the curve of the sign, so it looks terrible. What we’re going 
to do instead is use Tim’s method to create text that actually curves along the sign face. 

Let’s start off with drawing your curved sign face. To do this, we’re going to use the circle tool and the scale tool to make an 
oval wall. Draw a circle with the circle tool. After you do this, select the circle and click on the scale tool. When you do this, 
your circle will look like this – 
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We don’t want our sign to be a circle, we want it to be an oval, so we’re going to use the scale tool to make this happen. 
Hold the CTRL key and click and drag on one of the green points on the red line, as shown below. 

 

When you hold the CTRL key in the scale tool, it uniformly scales, meaning it scales equally both in the direction you are 
dragging, and in the direction directly opposite the direction you are dragging across the center of the object (see illustration 
below). 
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Now we’re going to create our curved wall. Start off by drawing a line across the center of the oval and deleting half of the 
oval. We only need one half of the circle for our sign. 

 

This will give us an oval that looks like the image below. 
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Go ahead and right click on the middle of the model and select the option for “Reverse Faces.” This should change the color 
of the fill of your model to a white color instead of the dark grey. 

Now, use the offset tool twice. The first time you do this, it will be to create the thickness of your lettering. The second time 
will create the thickness of your sign itself. 

Your model should now look like this. THIS NEXT STEP IS IMPORTANT. Double click inside each one of your lines, right 
click, and select the “make group” option. This will create 2 groups, one for each one of your walls. If you don’t do this, later 
on you won’t have a face for your signage wall, and this method WILL NOT WORK. 

 

Go ahead and double click inside this group, then use the Push/Pull tool to extrude these walls up to the height you would 
like your sign to be. To do this, simply click on the push pull tool, then click on the fill inside these shapes and drag up. Your 
model should now look like the image below. 
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What we’re going to do next is use the 3d text tool to create our text. I find it easiest to create a flat surface as a guide to 
place our 3d text on. To do this, draw two lines straight out on the green axis, one from the top left corner of the wall, the 
other from the bottom right corner. Draw a rectangle from one line to the other, as shown in the image below. 

 

Now select the 3d text tool and enter in your text. In my case, I’ve selected “The SketchUp Essentials.” Uncheck the 
“extruded” button. You can adjust your height, but we’re going to change it anyway, so I wouldn’t worry about it. Click on the 
“Place” button to place your text. 
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Your text will show up on the screen, but you’ll have to place it. Click on the lower left hand corner of the flat face you 
created to place your text. This will place your text on the screen. 

 

As you can see on the screen, your text won’t quite be centered where you want it. Use the move tool to center your text 
and the scale tool to resize it so that it fits the way you like. 
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Once you’ve done this, go ahead and delete your flat surface guides. Also, move your text closer to your wall so you won’t 
have to extrude it so far. 

 

Now what you’re going to do is double click inside your text and use the push pull tool to extrude your text through your wall. 



 

32 | P a g e  
 

 

Now select everything in your model, right click, and click the “Explode” option. 

 

This will delete all the groups in the selection and take everything back to its ungrouped state. Next, right click and select the 
“Intersect faces with model” option. 
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Now that you’ve done this, go through and delete out your text, leaving your model as shown below. 

 

Now go through and delete your front wall while leaving your text. Your model will now look something like the model below. 
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You’ll probably be have some letters missing their front faces. However, this is easy to fix. Just go in and draw lines across 
the empty faces and the letter should heal. See below for an example. 

 

Go through and clean up all your letters, and you should have a model that looks like what is shown below. 

 

This looks ALMOST the way we want it to. Select your erase tool, go in and while holding the shift key, click on these lines 
on your sign to hide them. 
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When you get done, you’ll have a sign with 3d text on it that curves along the face of the wall! 

 

 

Justin Geis 

www.thesketchupessentials.com 

  

http://www.thesketchupessentials.com/author/justin/�
http://www.thesketchupessentials.com/�
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Modeling a pool in SketchUp 

In this tutorial I will show how to model a simple swimming pool in SketchUp and Indigo, with nice caustics at the bottom of 
the pool. This is what we will be making: 

 

Model the pool ground and walls 

Create a quad like so: 

 

Create a rectangle in the middle of the quad: 
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Using the Push/Pull tool, push the middle down to create the pool recess: 

 

Create the water volume 

Create a cuboidal volume for the pool water. It needs to be somewhat larger than the pool recess along all axes. 
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Create the water material 

Create a new SketchUp material called 'water' or similar. 

Set the opacity to something around 50% to make sure the water material is transparent. 

 

Apply the material to all faces of the water volume. 
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Move the water volume into place 

Move the water volume into place with the move tool. The sides of the water volume should extend past the pool recess like 
so: 

 

Finishing the water material 

We need to set a couple of settings in the water material - some absorption to give the water a blue/green tint, and some 
displacement, to create the water ripples. 

Open the SkIndigo material editor, and make sure the 'water' material is selected. 

Change the material type to 'specular': 
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Change the Absorption type to 'none'. 

 

Click the dotted button to the right of 'Absorption'. 
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Set the RGB absorption to R: 0.2, G: 0.12, B: 0.1: 

 

Now we need to create the displacement shader. 

Check the 'Displace' checkbox in the SkIndigo material editor,and set the type to 'Shader'. 

Now click on the dotted button to the right of 'Displace'. 

Paste the following shader code in to the shader editor: 

def eval() real : 

fbm(posOS() * 2.0, 2) * 0.02 

Like so: 
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What this shader does is displace the water surface by up to 2 cm (0.02 m), based on some pseudo-random noise (fbm) 
based on the object-space position (posOS). 

If you want to make the ripples higher, you an increase the 0.02 number. 

If you want to make the ripples more closely spaced, you can increase the 2.0 number. 

Setting subdivision on the water volume 

We want to make sure that only the water volume mesh gets subdivided. 

To do this, first make sure the entire water volume object is fully selected by triple-clicking on it: 

 

Now right click on it, and choose 'Make Group'. 
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Now double-click on the group to select it. This should grey everything else out: 

 

Now right click on the pool volume and choose 'Edit Active Mesh' from near the bottom of the menu. It should say something 
like 'Group#1 (6 faces)' at the top of the SkIndigo Mesh Settings dialog. 

Set 'Max Subdivisions' to 8. This will turn each original quad face into 4^8 = 65536 subdivided faces. 

Also un-check the 'View Dependent' checkbox, and set 'Curvature Threshold' to zero: 
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Make the final render 

First off, we have to change the render mode to Bidirectional with MLT: 

This is very important as it's the most efficient mode for rendering these kind of caustics. 

 

Position the camera above the pool, then press the 'Render in Indigo' button. 

After a while, you should get an image like this: 

 

You may have to be a little patient waiting for the render - even with bidirectional MLT, it can still take a while. 

You can download the SketchUp scene (.skp) file here. 

http://www.indigorenderer.com/sites/default/files/skup_pool_tut.zip�
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Modeling Buzz Lightyear with Sketchup 

With this tutorial I will try to explain step by step stages to model Buzz Ligthyear with Sketchup. 

We start from the head. 

 

The first thing to do is to search the network for a 'picture that allows us to have a vision of' the subject from various points 
of view as ablueprint. 

So we begin to draw the contours of the profile and then create a model of the head pretty rough. 

 

We create a mask outlining the face and all its parts, eyes, eyebrows, mouth, nose ... you do not need because we already 
sketched. 

http://simo-3d.blogspot.it/2013/03/le-immagini-blueprint.html�
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At this point we position the mask in such a way as to center it perfectly in front of the solid of the head, then we project all 
its parts as in the picture below. Then highlight the whole thing and with the right mouse button, from the menu, click on 
"intersect faces" - "with the pattern". 

 

As you can see, after clearing the mask, remain on the solid segments of intersection of the projections. Now we can begin 
to shape the face starting from the eyebrows. 

http://simo-3d.blogspot.it/2012/01/intersecare-due-modelli.html�


 

47 | P a g e  
 

 

Draw a border around the eyebrow, that in 'picture I just colored yellow to highlight it, this will allow us to have a break over 
the net with his forehead when we use the plugin "Subdivide and Smooth." Same thing we do with the other eyebrow. 

 

We model the rest, occasionally use the plugin " Subdivide and smooth "to verify that the result is what you wanted and no 
inaccuracies. 

 

http://simo-3d.blogspot.it/2012/05/plugin-per-sketchup-subdivide-and.html�
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Finished sculpt the face, always with " Subdivide and smooth ", we set l '" Iterations "to the value 2, this will give us a good 
roundness of the edges, like the photo below. To better understand the steps performed up to this point you can download 
the template HERE. 

 

If the result satisfies us it's time to color. It should bring the model before using the plugin, we color all the parts and then 
with the plugin " Subdivide and smooth ", as well as setting the '"Iterations" to the value 2, we click the "On" to "Copy 
Materials" in this so we will not lose the colors set. 

To create the cap copy the model of the head before the " Subdivide and Smooth "and using the same plugin, this time we 
set l '" Iterations "to the value 1 then create a mask that will determine the shape of the hood on the face. Then, after you 
have highlighted all, with the right mouse button open the drop-down menu and click on "intersect faces" - "with the model." 

http://sketchup.google.com/3dwarehouse/details?mid=ed6bd216a30344b7d9d3572bbd9cf789&prevstart=0�
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Delete the whole part of the face that we are not interested and we create, to 'opening, a rim inwards to give it some 'thick, 
just copy the segments of the same and reduce its size. Now we can round up better with the plugin "Subdivide and 
smooth" setting the value "Iterations" still at 1. 

 

Set the cap and having it colored, 

http://simo-3d.blogspot.it/search/label/Plugin%20per%20Sketchup�
http://simo-3d.blogspot.it/search/label/Plugin%20per%20Sketchup�
http://simo-3d.blogspot.it/search/label/Plugin%20per%20Sketchup�
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the same way as when we screened the shape of the eyes, eyebrows, etc.. we project the iris. 

 

It can happen that by doing this, especially when the models are more complex, the result of the projection is not perfect so 
it will need a little work. 
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Remember that the plugin "Subdivide and smooth" requires a few minutes of processing (also depends on our pc) that 
increase if you click" On "to" Copy Materials "also means an increase in size, which means a greater weight of mock up. 

 

 

  

http://simo-3d.blogspot.it/2012/05/plugin-per-sketchup-subdivide-and.html�
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Shaping a shelby with Sketchup 

At the bottom of some steps of the modeling of the body of a Shelby, as usual, I start with a picture Blueprint and then 
continue to the eye. 

 
For the reconstruction of the dashboard, I was inspired by a photo found in the network. 

 
Some views of the finished model. 
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Creating a Screw with Sketchup 

How many times you have wondered how to make the thread of a screw with SketchUp, or not? Here is the answer! 

First you draw a circle. We click on the instrument "Circle" in the toolbar and then on the point of origin of the axes and 
widen our circle by following one, red or green, with the cursor, so that the vertices of the segments that make up the match 
with aces. 

 

Created the circle, from this, we have to create a spiral. The steps to follow are the same that you can find in the post "HOW 
TO CREATE A SPRING WITH SKETCHUP", would not explain them again. 

Now we have a cylinder created by the initial circle and a spiral of the same diameter with the plugin "Weld" we welded into 
a single segment. 

 

http://simo-3d.blogspot.it/2012/08/rettangolocerchio-e-poligono.html�
http://simo-3d.blogspot.it/2013/01/tutorial-creare-una-molla-con-sketchup.html�
http://simo-3d.blogspot.it/2013/01/tutorial-creare-una-molla-con-sketchup.html�
http://simo-3d.blogspot.it/2013/01/tutorial-creare-una-molla-con-sketchup.html�


 

56 | P a g e  
 

It 'important to create a group of one of the two models, in this case, my group is the spiral. This is to avoid that the two 
models, when superimposed, is intersichino between them. Then we position the spiral over the cylinder so that the 
segments coincide perfectly with each other. 

 
We click on the instrument "Move" and then on the group spiral with the "CTRL" key to create a copy, spostiamola down 
along the blue axis until it reaches the center of the original one (see image below). 

 

Now we can explode groups of spirals so as to intersect the segments with those of the cylinder. 
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We click on the spiral just created to highlight it , then the instrument "Scale" and finally, with the CTRL key pressed on the 
handle of the solid angle at the center, ... 

 

... Pull outwards and ... 
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The screw ... is ready. 

 

Under another example of a solid made with the same method created simply by moving the internal spiral downwards. 



 

59 | P a g e  
 

 

Or this' other using the plugin "Joint Push-Pull". 

 

http://simo-3d.blogspot.it/2012/03/joint-push-pull.html�
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SketchUp getting started 
Getting started with SketchUp is a matter of getting familiar with the workspace and some simple navigational shortcuts. 
Then we would look at the basic modeling workflow, adding materials and shadows. 

And finally outputting still images. We go through all the essential elements of working with the program in our SketchUp 
courses. 

Firstly, the interface consists of 4 main elements: the model window, the toolbar, the menu drop-down at the top, and the 
Status bar on the bottom of the screen. 

If you hold your cursor over any of the tools on the toolbox, a small tool tip appears after a second or so – this reminds you 
of what that tool actually does. Also note that a tip appears on the bottom left of the screen, giving basic instructions. This is 
a bit like the Command window in Autocad. There’s also an Instructor icon which opens a preview box for chosen tools. 

On the top of the interface you have the Menu drop-downs – these are alternate ways of performing tasks, and usually 
represent the slower method. But some of them are very useful, for example the View drop-down allows you to choose to 
display more Toolbars. The Camera drop-down allows you to change the Field of View, etc. And the Window menu allows 
you to display panels like Layers and Styles. To add extra useful tools: View > Toolbars > Large Tool Set (Mac: View > Tool 
Palettes). And to open the default views icons: View > Toolbars > Views. 

The Status bar at the bottom gives tips of using the tools, and on the right also allows you to enter dimensions for drawn 
objects and scaling, etc. 

Navigational tools and commands are essential to working in SketchUp – note the Zoom, Pan and Orbit tools in the toolbox. 
But using shortcuts for these will speed up your workflow. To zoom hit Z to jump to the Zoom tool, or simply roll your mouse-
wheel. To Orbit around your model hit O, or simply click and drag your mouse-wheel. And to Pan across the screen hit H 
(for Hand), or press Shift and click & drag your mouse-wheel. 

Next we would create some basic shapes with the Rectangle, Line and Push/Pull tools – we cover these in another blog 
post. 
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Ref : www.designworkshopsydney.com.au 

 

http://www.designworkshopsydney.com.au/sketchup-getting-started/�
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Turn Your iPad into a 3D Scanner with Itseez3D 
As 3D printing has become a more viable pastime for the technologically inclined, there’s a similarly growing need for quick, 
easy, and accurate 3D modeling. 

To address that need, last week computer vision firm Itseez released a new, free iPad app that provides users a quick and 
painless way to make 3D renderings of everyday objects. 

The concept behind Itseez3D is simple: activate the app and walk around the object you want to scan. From there, the app 
offloads the work of rendering the image on computing power from “the cloud and returns with a complete 3D model within 
minutes.” 

https://www.youtube.com/watch?v=jyAF47newGU 

There is a catch, however: just as the iPad can’t handle the processing power to render the image itself, its camera likewise 
isn’t powerful enough to capture the images in the first place. For that, a user will need the Structure Sensor from Occipital, 
a $400 camera ($500 with a mount) built for the iPad that raised over $1.2 million in a Kickstarter campaign last year. 

Said Itseez co-founder and CEO Victor Erukhimov on the Structure Sensor’s potential: 

“We recognized the immense potential of Structure Sensor early on, and Itseez3D represents our efforts to weave advanced 
computer vision technology with this innovation. Essentially, we’ve made high quality 3D model creation faster, more 
accessible and more cost-effective than ever before. We’re excited to find out how professional and recreational users will 
leverage this technology.” 

In essence, the combination of Itseez3D and the Structure Sensor seems capable of much the same kind of functionality as 
Project Tango, Google’s experimental 3D mapping smartphone and tablet. That device packs the power to handle 3D 
modeling all on its own – but it’s not available to the public right now. On the other hand, Itseez3D and the Structure Sensor 
can be purchased and used by hobbyists and developers at this very moment. 

The Structure Sensor isn’t cheap, but then, it seems to boast some pretty powerful abilities. If you’ve already got a current-
gen iPad (G4, Mini, or Air), you can start 3D modeling right now. If I had a 3D printer, I’d be even more tempted than I 
already am. Chances seem good that this is just the beginning of 3D modeling applications. Itseez3D and Occipital have 
opened the door to some really interesting new capabilities for the iPad, what’s typically a consumption device. It’s exciting 
to think about what’s coming next. 

As for the future of Itseez3D on other platforms, a spokesperson for Itseez says that it all depends on whether or not other 
sensors with the same kind of power are made for Android or other devices. Even still, considering that the iPad is the most 
popular tablet out there, chances seem good that there will be no shortage of potential customers. 

 

https://www.youtube.com/watch?v=jyAF47newGU�
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Ref : www.besttechie.com 

 

  

http://www.besttechie.com/2014/07/11/turn-your-ipad-into-a-3d-scanner-with-itseez3d/�
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Trimble Participates in First-Ever White House Maker Faire 
Trimble is proud to be a participant in the first-ever White House Maker Faire, held today to showcase the Maker Movement 
— tinkerers, inventors, and entrepreneurs who promote entrepreneurship and innovation — and the tools and technologies 
they rely on to do so. Through SketchUp, the "3D for everyone" design tool used by 30 million designers, builders and 
makers of things every year, Trimble has become closely involved with the Maker Movement. 

"It is an honor to participate in this White House event," said Steven W. Berglund, president and CEO of Trimble. "Today we 
saw innovators of all ages using tools like SketchUp to help shape the future. There has been a lot of talk lately about how 
the Maker Movement will transform and revitalize American manufacturing. Today's event demonstrated that the 
possibilities are endless." 

Maker Faire, organized by Maker Media, is a gathering of curious and innovative people who enjoy learning and who love 
sharing what they can do. It's a venue for makers to show examples of their work and interact with others about it. There are 
now more than one hundred Maker Faires a year around the world. The White House Maker Faire is the latest installment. 

Among the wide range of SketchUp projects showcased this year is the "WikiHouse," an open source housing design 
system developed in SketchUp and fabricated directly with robotic machine tools. WikiHouse was implemented through a 
unique collaboration between U.K. design firm 00 ("Zero-zero"), ShopBot Tools, Vectric CAM software and the SketchUp 
team. Trimble has exhibited several WikiHouse prototypes, at events including Maker Faires in New York and the Bay Area, 
as well as at the USA Science and Engineering Festival in Washington, D.C. 

While SketchUp was originally designed to meet the needs of architects and building construction professionals, it rapidly 
became the design tool of choice tool for inventors across a wide range of industries. In the spirit of open collaboration that 
defines the Maker Movement, Trimble continues to offer SketchUp Make for free to makers around the world. 

"On the SketchUp team, we think of ourselves as 'meta-makers,'" said John Bacus, director of product management for 
SketchUp. "In other words, we make the tools that help makers do their work more efficiently." 

Since 2006, SketchUp Make has been used to design everything from 3D printable parts to the 3D printers on which those 
parts are made. Robots, DIY satellites, jetpacks, hovercraft and home brewing machines have been designed in SketchUp 
Make, as well as countless greenhouses, sheds and woodworking shops. 

Additionally, Trimble's 3D Warehouse is available at no cost to makers as a place to share their work and collaborate with 
others. Today, there are more than 2.5 million models shared there. "Browsing the pages of 3D Warehouse is like walking 
through a museum of invention, all freely shared and available for reuse and improvement by others," said Bacus. 

Today, at the first-ever White House Maker Faire, Trimble has committed to expanding its free software services to makers 
by adding cloud based software and 3D printing tools. 
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Ref : www.gisuser.com 

 

 

http://www.gisuser.com/content/view/33302/2/�
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Inside3DP Exclusive : 3D Printing Maven Releases Four New 3D Printers 
3D Printing maven and inventor Richard Horne released 4 new 3D printers today sharing the files for them so that anyone 
can use these designs. Richard has been doing a lot of innovating in color mixing, deltas and different extruders for the past 
few years. 

The geared peristaltic quick fit extruder for example lets you 3D print in many different materials. He also comes up with lots 
of great designs such as a pencil topper for kids and a 6 stage planetary gears set. This time Richard raises the bar even 
higher with a 1.80m Delta 3D printer, the 3DRMega. 

This huge machine lets you make really large objects and is a real breakthrough. Instead of tiny things this enables the 
making of true human scale objects such as chairs, tables etc. 

Richard used Sketchup to design the printer. He completed it in February this year but redesigned it since then. The printer 
uses LM10UU bearings and rods, NEMA 23 steppers, the ARM Smoothie board & the Delta arms are made from carbon 
fiber tent poles as well as a redesigned geared extruder. A 10mm clear corrugated poly-carbonate roof sheeting is wrapped 
around the frame. 

The printer uses around 2 Kilo of 3D printed parts. An interesting element is that the printer is designed to be “bottomless” in 
that you could place it on an object and then print on top of this. 

This means you could in situ 3D print on top of an existing structure. All the motors and other electronics are mounted at the 
top of the printer. You can put in a base of 12mm Ply base, Cork insulation, thermally reflective sheets made from Bar B 
Que grill pads with 4mm sheet of glass on top. This gives the 3D printer a heated build chamber. 

I contacted Richard and had a quick interview with him about his new gigantic 3DRMega. 

Joris Peels: Why did you make this huge machine? 

Richard Horne: The wish list for designing 3D printers and new applications is growing ever longer. Also I noticed that bigger 
3D printers, even normal desktop size ones were increasing in cost substantially. I wanted to get back to a machine you 
could print and build yourself, but with high quality results. 

Joris Peels: Who did you make this for? 

Richard Horne: My initial target was to artists for large prints and also for sculpture and furniture. I have various extruders in 
development, one pumps clay/ceramic and even chocolate materials via a pressurized tube. You can’s use syringes of 
material as they don’t even last for one layer of a big print. A constant flow of material is essential. Other extruders are using 
screw drives. This new extruder design is a very exciting area for development and once established and refined will change 
the landscape of 3D printing, a real game changer. 

Joris Peels: What are next steps? 

Richard Horne: Ideally I would like to make custom printers for specific applications and then help refine that use with 
people who need good results. Like all my developments I like to see what people think about it and also what they would 
like to be able to do with the machine. 

Joris Peels: Can I buy one? 

Richard Horne: I tend to keep my prototypes, but really I should sell some to make space. 

Joris Peels: Will you sell it as a kit? 

Richard Horne: This 3D printer would work very well as a kit and extending or shrinking it’s size is all down to the aluminium 
extrusions. So it’s a very flexible design to make a printer whatever size you need. 
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Ref : www.inside3dp.com 

http://www.inside3dp.com/inside3dp-exclusive-3d-printing-maven-releases-four-new-3d-printers/�
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3D modeling with Sketchup make Trimble 
Basic Course organized by the Order of Architects PPC of the Province of Forlì in collaboration with Visuall SRL.S. have 
been recognized, no. CFP 6 from CNAPPC . 

The objective of the course is to give participants the tools needed to design and modeling three-dimensional objects from 
design to architecture. At the end of the course the student will be able to use all the tools for modeling, listed models and 
management of the views to be able to print their work or share them on the screen and by e-mail. 

Participation fee € 130.00 + VAT registration closes : 15/07/2014 length n. 6 hours 

Mode of entry send the request for pre-registration form to: Visuall SRL.S (visuall@visuall.it), stating its personal and fiscal 
(tax code., and P. Iva), telephone and email. From the date of confirmation of registration, which will be forwarded via e-mail 
from Visuall SRL.S, and / or communicated by telephone, the subscriber will have to proceed to the payment of the balance 
in the time of the next 3 days, sending the response of payment via e-mail. If you do not receive the indicated time, the 
enrollment will be canceled. 

Appointment : Saturday, July 19, 2014 from 8.30 to 12.30 and from 13.30 to 15.30 at Visuall Showroom via Decius Rays 2, 
Forli 
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Ref : www.professionearchitetto.it 

  

http://www.professionearchitetto.it/formazione/notizie/19630/Modellazione-3D-con-trimble-sketchup-make�
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How Desktop 3D Printers are 100% Useful to Our Daily Lives 

Lets face it – desktop 3D printers are far from meeting the standards of the average consumer. They are too complex for 
most non-technologically-minded people, and worst of all, they can only print small, hard objects from limited types of 
plastic. What on earth can be so useful about printing small, hard objects? 

As it turns out, quite a lot. 

Just 2% of the cost 

An office supplies company in Townsville, Australia called Delta Office Solutions recently experienced firsthand just how 
handy it can be to own a 3D printer. The company’s office dishwasher broke, due to a small part that snapped and caused 
the loading tray to detach from its wheels. Office managers at the company looked into ordering new parts and found that it 
would cost $45 and take four days. Instead of waiting, they decided on a more efficient solution that would dually save 
money. 

Two of the company’s employees Brian Worley and Adrian Smith took on the challenge of using the office’s desktop 3D 
printer to make the dishwasher piece themselves. They used Google’s free Sketchup design app to make 3D model files of 
the part, and they put their printer to the test. Within three hours, the pair had a brand new, 3D printed exact replica of the 
piece in their hands. 

Worley said it cost them just $1.60 for the cost of materials – about two percent of the retail price. “It can take up to four 
days to get missing parts and other stuff from Sydney but now people can make things on their own,” said Worley. 

Saving money while making a little extra on the side, too 

This team of Australians is far from being the first to take advantage of the handy convenience of a desktop 3D printer. In 
May, we spoke to an entrepreneur by the name of Christopher Sweeney who used his MakerBot desktop printer to solve “at 
home fix-its” in his Hawaii home and had even turned his endeavors into a company, selling bespoke objects to people 
around the US. 

“The options for what I can make are limitless. I can make anything as simple as an office desk accessory such as a pen or 
card holder, to something as complex as a custom art piece,” said Chris. “It has also been convenient to solve ‘at home fix-
it’s’. If something breaks, instead of having to go to the hardware store hoping they have the part I need in specific 
dimensions, I can create the broken piece in a matter of hours.” 

So if you have ever found yourself rushing to Home Depot to overpay for a specific part, tool or gadget, or if you have ever 
had to wait more than a few hours for the arrival of a part that is absolutely pivotal to the functionality of your showerhead, 
dishwasher or TV stand, then perhaps it is about time you looked into investing in a desktop 3D printer. 
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Magazine Details – The Creative team of Sketchup-ur-Space 

 

Started in September 2010, Sketchup ur Space (SuS) was the first online magazine devoted to SketchUp, that 
unique, innovative 3D design tool from Google. It holistically covers features, events, news, updates, reviews 
and many tips and tricks. 
 

 

Rajib Dey: rajib@sketchup-ur-space.com 

Rajib, the editor-in-chief of SketchUp ur Space magazine is the main writer. He is 
responsible to write the cover story, blog and many other columns. Along with it, He is 
creating a liaison between the writers and the readers. 

 

 

Manoj Kumar Singh: manoj@jobs2india.com 

Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in 
the html version. Manoj is the html developer who beautifully creates each and every 
edition with care along with the PDF version. 

 
 

 

Abhishek Mondal: abhishek@jobs2india.com 

Abhishek is the designer-in-chief of this magazine with the help of his creativity 
Sketchup ur Space has gotten a classy as well as trendy look... 
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